
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Read this manual carefully before installing,
wiring, operating, servicing or inspecting this 
equipment.  
 

 Keep this manual within easy reach for
quick reference. 

LS Programmable Logic Controller

XGT Analog Input Module
XGF-AC8A / XGF-AV8A



 

Safety Instructions 

Before using the product … 
 
For your safety and effective operation, please read the safety instructions 
thoroughly before using the product. 
 
► Safety Instructions should always be observed in order to prevent accident 

or risk with the safe and proper use the product. 
 
► Instructions are separated into “Warning” and “Caution”, and the meaning of 

the terms is as follows; 
 

This symbol indicates the possibility of serious injury 
or death if some applicable instruction is violated  

 
This symbol indicates the possibility of slight injury 
or damage to products if some applicable instruction 
is violated  

 
► The marks displayed on the product and in the user’s manual have the 

following meanings. 

Be careful! Danger may be expected. 

Be careful! Electric shock may occur. 
 
► The user’s manual even after read should be kept available and accessible 

to any user of the product. 

Warning 

Caution 



 

Safety Instructions 

Safety Instructions when designing 
 

 

 

 

 

 

 

 

 

 

 

 Please, install protection circuit on the exterior of PLC to protect 
   the whole control system from any error in external power or PLC 

 module. Any abnormal output or operation may cause serious problem 
 in safety of the whole system.  

- Install applicable protection unit on the exterior of PLC to protect 
the system from physical damage such as emergent stop switch, 
protection circuit, the upper/lowest limit switch, forward/reverse 
operation interlock circuit, etc. 

- If any system error (watch-dog timer error, module installation error, 
etc.) is detected during CPU operation in PLC, the whole output is 
designed to be turned off and stopped for system safety. However, 
in case CPU error if caused on output device itself such as relay or 
TR can not be detected, the output may be kept on, which may 
cause serious problems. Thus, you are recommended to install an 
addition circuit to monitor the output status. 

 

 Never connect the overload than rated to the output module nor 
 allow the output circuit to have a short circuit, which may cause a 
 fire. 
 

 Never let the external power of the output circuit be designed to 
  be On earlier than PLC power, which may cause abnormal output or 

operation. 
 

 In case of data exchange between computer or other external 
equipment and PLC through communication or any operation of 
PLC (e.g. operation mode change), please install interlock in the 
sequence program to protect the system from any error. If not, it 
may cause abnormal output or operation. 

Warning 



 

Safety Instructions 

Safety Instructions when designing 
 

 

 

 

 

 

 
 

Safety Instructions when designing 

 I/O signal or communication line shall be wired at least 100mm 
  away from a high-voltage cable or power line. If not, it may cause 
 abnormal output or operation. 

Caution 

 Use PLC only in the environment specified in PLC manual or 
general standard of data sheet. If not, electric shock, fire, abnormal 
operation of the product or flames may be caused. 

 

 Before installing the module, be sure PLC power is off. If not, 
electric shock or damage on the product may be caused. 

 

 Be sure that each module of PLC is correctly secured. If the 
product is installed loosely or incorrectly, abnormal operation, error or 
dropping may be caused. 

 

 Be sure that I/O or extension connecter is correctly secured. If 
not, electric shock, fire or abnormal operation may be caused. 

 

 If lots of vibration is expected in the installation environment, 
don’t let PLC directly vibrated. Electric shock, fire or abnormal 
operation may be caused. 

 

 Don’t let any metallic foreign materials inside the product, which 
may cause electric shock, fire or abnormal operation.. 

Caution 



 

Safety Instructions 

Safety Instructions when wiring 
 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Prior to wiring, be sure that power of PLC and external power is 
turned off. If not, electric shock or damage on the product may be 
caused. 

 
 Before PLC system is powered on, be sure that all the covers of 
the terminal are securely closed. If not, electric shock may be caused 

Warning 

 Let the wiring installed correctly after checking the voltage rated 
of each product and the arrangement of terminals. If not, fire, 
electric shock or abnormal operation may be caused. 

 

 Secure the screws of terminals tightly with specified torque when 
wiring. If the screws of terminals get loose, short circuit, fire or abnormal 
operation may be caused. 

* 
 Surely use the ground wire of Class 3 for FG terminals, which is 
exclusively used for PLC. If the terminals not grounded correctly, 
abnormal operation may be caused. 

 

 Don’t let any foreign materials such as wiring waste inside the 
module while wiring, which may cause fire, damage on the product 
or abnormal operation. 

Caution 



 

Safety Instructions 

Safety Instructions for test-operation or repair 
 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Safety Instructions for waste disposal 
 

 

 

 

 

 

 Don’t touch the terminal when powered. Electric shock or abnormal 
operation may occur. 

 

 Prior to cleaning or tightening the terminal screws, let all the 
external power off including PLC power. If not, electric shock or 
abnormal operation may occur. 

 

 Don’t let the battery recharged, disassembled, heated, short or 
soldered. Heat, explosion or ignition may cause injuries or fire. 

Warning 

 Don’t remove PCB from the module case nor remodel the module. 
Fire, electric shock or abnormal operation may occur. 

  
 Prior to installing or disassembling the module, let all the external 
 power off including PLC power. If not, electric shock or abnormal 
operation may occur. 

 

 Keep any wireless installations or cell phone at least 30cm away 
from PLC. If not, abnormal operation may be caused. 

Caution 

 Product or battery waste should be processed as industrial waste. 
The waste may discharge toxic materials or explode itself. 

Caution 
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Chapter 1 Introduction 
This user’s manual is to describe XGF-AV8A type of analog voltage to digital conversion module 

(hereinafter referred to as XGF-AV8A) and XGF-AC8A type of analog current to digital conversion module 
(hereinafter referred to as XGF-AC8A) used as associated with XGT PLC series of CPU module about their 
specifications, treatment and programming, which will be hereinafter referred to as A/D conversion module, a 
general term of XGF-AV8A and XGF-AC8A. 
A/D conversion module is used to convert analog signal (voltage or current input) from PLC’s external device 
to signed 16-bit binary data of digital value. 
 
 1.1 Characteristics 

 

1) Selection of a module based on purpose 
 XGF-AV8A: 8 channels, voltage input 
 XGF-AC8A: 8 channels, current input 

 

2) High speed conversion 
High speed conversion can be processed through 250 ㎲/channel. 
 

3) High accuracy 
High conversion accuracy of ±0.2 % (ambient temperature of 25 ± 5 ) is available℃ .  
 

4) High resolution of 1/16000  
High resolution of 1/16000 can be selected to obtain digital value of high resolution. 
 

5) Operation parameters setting / monitoring through GUI (Graphical User Interface) 
Operation parameters setting which was by using traditional commands is available now by 
means of [I/O Parameters Setting] for which user interface is reinforced to increase user’s 
convenience. With [I/O Parameters Setting] used, the sequence program can be reduced. In 
addition, through [Special Module Monitoring] function, A/D conversion value can be easily 
monitored.  

 
6) Various formats of digital output data provided 

4 formats of digital output data are available as specified below; 
 Unsigned Value: 0 ~ 16000 
 Signed Value: -8000 ~ 8000 
 Precise Value: Refer to Chapter 2.2 Display based on analog input range. 
 Percentile Value: 0 ~ 10000 

 
7) Input disconnection detection function 

This function is used to detect the disconnection of input circuit when 1 ~ 5 V (4 ~ 20 mA) of 
analog input signal range is used. 
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 [Fig. 1.1] Analog Quantity            [Fig. 1.2] Example of Transducer 
 

1.2.1 Analog quantity - A  
What is displayed in numerical value with continuous physical quantity is called Analog Quantity. 
Since the size of analog changes continuously, any middle value can be taken from it in which 
general physical quantities such as voltage, current, temperature, speed, pressure and flow are 
included. For example, temperature can change continuously together with time as shown in Fig. 1.1. 
Since the changing temperature can not be input directly on A/D conversion module, it shall be input 
on A/D conversion module through the transducer converting identical analog quantity of input signal 
to electric signal. 

 
1.2.2 Digital quantity - D 

 
What is displayed in data or numerical value such as 0, 1, 2 
and 3 with data or physical quantity is called Digital Quantity. 
Digital in (Fig. 1.3) stands for electronic technology to create, 
save and process the data through 0 and 1 only. Accordingly, 
the data sent or saved with digital technology will be displayed 
in a string of 0 and 1 continuously used. For example, On and 
Off signal can be displayed in a digital quantity of 0 and 1. BCD 
and binary value is also the digital quantity.  

[Fig. 1.3 Digital Quantity] 
      
 

Analog quantity can not be directly input on PLC CPU for 
calculation. Thus, convert analog quantity to digital quantity as 
in Fig. 1.4 so to input on PLC CPU, which will be executed by 
A/D conversion module. 
In addition, in order to output the analog quantity outward, 
convert PLC CPU’s digital quantity to analog quantity, which 
will be executed by D/A conversion module 

 
 
 
 
 
 

 1.2. Terminology 

CPU 
 

A/D D/A 

Analog Input 
0~10V, 1~5V 

or 
4~20㎃ 

Analog Output 
0~10V, -10~10V

or 
4~20㎃ 

[Fig. 1.4] Process in PLC 

 

Time 

Tem
pera
ture 

 Temperature 
0~1000℃ 

 
Transducer

Voltage: -10~+10V 
 A/D conversion 
Input on module 

Time 

Tem
pera
ture 

conversion conversion (Digital Calculation) 
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1.2.3. Characteristics of analog/digital conversion  

1) Voltage Input 
 

 
[Fig. 1.5] Characteristics of A/D conversion (Voltage Input) 

 
A/D conversion module is used to convert analog electric signal input from the external device to 

digital quantity. Analog input signal converted to digital quantity can be calculated in PLC CPU. If 
analog input range of -10 ~ 10 V is used in voltage type of A/D conversion module, -10 V of analog 
input quantity will be output with digital value of 0, and 10 V of analog input quantity will be output with 
digital value of 16000, where consequently, analog input of 1.25 ㎷ is equivalent to digital value of 1. 
(Fig. 1.5) 
 

2) Current Input 
 

 
[Fig. 1.6] Characteristics of A/D conversion (Current Input) 

 
If analog input range of 0 ~ 20 ㎃ is used in current type of A/D conversion module, 0 ㎃ of analog 

input quantity will be output with digital value of 0, and 20 ㎃ of analog input quantity will be output 
with digital value of 16000, where consequently, analog input of 1.25 µA is equivalent to digital value 
of 1. (Fig. 1.6)  
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Chapter 2 Specifications 
 
  
2.1 General Specifications 

General specifications of XGT series are as specified in Table 2.1. 

[Table 2.1] General Specifications 
No. Item Specifications Related standards 

1 Operating 
temp. 0 +55℃∼ ℃  

2 Storage temp. -25 +70℃∼ ℃  

3 Operating 
humidity 5 95%RH∼  (Non-condensing)  

4 Storage 
humidity 5 95%RH (Non∼ -condensing)  

For discontinuous vibration  
Frequency Acceleration Amplitude Number
10≤f< 57 ㎐ - 0.075mm 
57≤f≤150 ㎐ 9.8m/s2(1G) - 

For continuous vibration 
Frequency Acceleration Amplitude 

10≤f< 57 ㎐ - 0.035mm 

5 Vibration  

57≤f≤150 ㎐ 4.9m/s2(0.5G) - 

Each 10 
times in 
X,Y,Z 

directions

IEC61131-2 

6 Shocks 

* Max. impact acceleration:147 ㎨(15G) 
* Authorized time :11 ㎳ 
* Pulse wave : Sign half-wave pulse (Each 3 times in X,Y,Z
 directions) 

IEC61131-2  

Square wave impulse noise ±1,500V LSIS standard 

Electrostatic discharging Voltage : 4kV(contact 
discharging) 

IEC61131-2 
IEC61000-4-2 

Radiated electromagnetic 
field noise 27 ~ 500MHz, 10 V/m IEC61131-2, 

IEC61000-4-3 

Class Power 
module

Digital/ 
Analog I/O 

communication interface

7 Noise 

Fast 
Transient 

/burst 
noise Voltage 2kV 1kV 

IEC61131-2 
IEC61000-4-4 

8 Ambient 
conditions No corrosive gas or dust  

9 Operating 
height 2000m or less  

10 Pollution 
degree 2 or less  

 
Notes  

 1) IEC (International Electrotechnical Commission): 
   An international nongovernmental organization which promotes internationally cooperated standardization in 

 electric/electronic fields publishes international standards and manages applicable estimation system related 
 with. 

2) Pollution level: An index indicating pollution level of the operating environment which decides insulation 
 performance of the devices. For instance, Pollution level 2 indicates the state generally that only 
 non-conductive pollution occurs. However, this state contains temporary conduction due to dew produced. 
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Performance specifications of A/D conversion modules are as specified in Table 2.2. 
 

[Table 2.2] Performance Specifications 
Specifications Item 

XGF-AV8A (Voltage Input Type) XGF-AC8A (Current Input Type) 

Analog input 

DC 1  5 V∼  
DC 0  5 V∼  

DC 0  10 V∼  
DC -10  10 V∼  

(Input Resistance: 1 MΩ min.) 

DC 4  20 ma∼  
DC 0 ~ 20 ma 

(Input Resistance 250 Ω) 

Analog input range 
setting 

► Analog input range can be selected through XG5000 user’s (or sequence) program or [I/O
parameter]. 
► Respective input ranges can be set based on channels. 

Digital output 

 
(1) Voltage Type 

        Analog input 
Digital output 

1 ~ 5 V 0 ~ 5 V 0 ~ 10 V -10 ~ 10 V 

Unsigned Value 0 ~ 16000 
Signed Value -8000 ~ 8000 

Precise Value 1000 ~ 
5000 0 ~ 5000 0 ~ 10000 -10000 ~ 

10000 
Percentile Value 0 ~ 10000 

 
(2) Current Type 

       Analog input 
 
Digital output 

4 ~ 20 ㎃ 0 ~ 20 ㎃ 

Unsigned Value 0 ~ 16000 
Signed Value -8000 ~ 8000 
Precise Value 4000 ~ 20000 0 ~ 20000 

Percentile Value 0 ~ 10000 
► 16-bit binary value (data: 14 bits) 
► Format of digital output data can be set through user program or S/W package respectively

based on channels. 

Max. resolution 

 
Analog input range Resolution (1/16000) Analog input range Resolution (1/16000)

1 ~ 5 V 0.250 mV 
0 ~ 5 V 0.3125 mV 

4 ~ 20 ㎃ 1.0 µA 

0 ~ 10 V 0.625 mV 
-10 ~ 10 V 1.250 mV 

0 ~ 20 ㎃ 1.25 µA 
 

Accuracy ±0.2% or less (when ambient temperature is 25  ±5 )℃ ℃  
±0.3% or less (when ambient temperature is 0  ~ 55 )℃ ℃  

Max. conversion 
speed 250 μs/channel 

Absolute max. 
input ±15 V ±30㎃ 

Analog 
input points 8 channels/1 module 

Insulation method Photo-coupler insulation between input terminal and PLC power  
(no insulation between channels) 

Terminal 
connected 18-point terminal 

I/O points 
occupied Fixed type: 64 points, Changeable type: 16 points 

Internal-consumed 
current DC 5 V: 420㎃  

Weight 140g 

 2.2 Performance Specifications 
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Notes  
1) When A/D conversion module is released from the factory, Offset/Gain value is as adjusted for respective 

analog input ranges, which is unavailable for user to change. 
2) Offset Value: Analog input value where digital output value is 0 when digital output format is set to 

Unsigned Value.  
3) Gain Value: Analog input value where digital output value is 16000 when digital output format is set to 

Unsigned Value. 
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2.3 Respective Designations and Functions 

 
Respective designations of the parts are as described below. 
 

2.3.1 XGF-AV8A/XGF-AC8A 
 
 

    
 
 
 

 
 

No. Description  

RUN LED ① 
▶ Displays the operation status of XGF-AV8A/XGF-AC8A  

On: Operation normal 
Flickering: Error occurs (Refer to 7.1 for more details) 
Off: DC 5V disconnected, XGF-AV8A/XGF-AC8A module error 

Terminal ② 

▶ Analog input terminal, whose respective channels can be connected with external 
devices. 

 

① 

② 
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XGF-AC8A 

XGF-AV8A 

 

 
Characteristics of I/O conversion are the inclination connected in a straight line between Offset and 

Gain values when converting analog signal (voltage or current input) from PLC’s external device to digital 
value. I/O conversion characteristics of A/D conversion modules are as described below. 

 
   
 

 
 
 

 

 
 

 2.4 Characteristics of I/O Conversion 

Digital 
Output 
Value

0

4000

8000

12000

16000
16191

-192
-8000

-4000

0

4000

8000
8192

-8192
0

2500

5000

7500

10000
10119

-120

DC 1 ~ 5 V

DC 0 ~ 5 V

DC 0 ~ 10 V

DC -10 ~ 10 V

1 V 5 V3 V

0 V 2.5 V 5 V

0 V 5 V 10 V

-10 V 0 V 10 V

Analog 
Input 
Value

Analog Input 
Applicable Range

Offset 
Value

Gain 
Value

Digital 
Output 
Value

0

4000

8000

12000

16000
16191

-192
-8000

-4000

0

4000

8000
8192

-8192
0

2500

5000

7500

10000
10119

-120

DC 4 ~ 20 mA

DC 0 ~ 20 mA

4 mA 20 mA12 mA

0 mA 10 mA
Analog 

Input Value

Analog Input 
Applicable Value

Offset 
Value

Gain 
Value

20 mA
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2.4.1 I/O characteristics of XGF-AV8A 
XGF-AV8A is a module exclusively used for 8-channel analog voltage, where Offset/Gain can not be 

adjusted by user. Voltage input range can be set through user program or special module package for 
respective channels. Output formats of digital data are as specified below; 

 
 A. Unsigned Value 
 B. Signed Value 
 C. Precise Value 
 D. Percentile Value 

 
1) If the range is DC 1 ~ 5 V 

 ▶ On the XG5000 menu [I/O Parameters Setting], set [Input range] to “1 ~ 5 V”. 
 

 
 

 
 ▶ Digital output value for voltage input characteristics is as specified below. 
(Resolution (based on 1/16000): 0.25 mV) 

 
Analog input voltage (V) Digital 

 Output range 0.952 1 2 3 4 5 5.047 
Unsigned value 
(-192 ~ 16191) 

-192 0 4000 8000 12000 16000 16191 

Signed value 
(-8192 ~ 8191) 

-8192 -8000 -4000 0 4000 8000 8191 
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Precise value 
(952 ~ 5048) 

952 1000 2000 3000 4000 5000 5048 

Percentile value 
(-120 ~ 10119) 

-120 0 2500 5000 7500 10000 10119 

 
2) If the range is DC 0 ~ 5 V 

 ▶ On the XG5000 menu [I/O Parameters Setting], set [Input range] to“0 ~ 5 V”. 
 

 
 

0

4000

8000

12000

16000
16191

-192
-8000

-4000

0

4000

8000
8192

-8192
0

2500

5000

7500

10000
10119

-120

0 V 5 V2.5 V

5060
5000

3750

2500

1250

0
-60

3.75 V1.25 V

Analog Input Value (Voltage)  
▶ Digital output value for voltage input characteristics is as specified below. 

(Resolution (based on 1/16000): 0.3125 mV) 
 

Analog input voltage (V) Digital 
Output range -0.06 0 1.25 2.5 3.75 5 5.05 

Unsigned value 
(-192 ~ 16191) 

-192 0 4000 8000 12000 16000 16191 

Signed value 
(-8192 ~ 8191) 

-8192 -8000 -4000 0 4000 8000 8191 

Precise value 
(-60 ~ 5060) 

-60 0 1250 2500 3750 5000 5060 

Percentile value 
(-120 ~ 10119) 

-120 0 2500 5000 7500 10000 10119 
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3) If the range is DC 0 ~ 10 V 

 ▶ On the XG5000 menu [I/O Parameters Setting], set [Input range] to“0 ~ 10 V”. 
 

 
 

 

 
 

▶ Digital output value for voltage input characteristics is as specified below. 
(Resolution (based on 1/16000): 0.625 mV) 

 
Analog input voltage (V) Digital 

Output range -0.12 0 2.5 5 7.5 10 10.11 
Unsigned value 
(-192 ~ 16191) 

-192 0 4000 8000 12000 16000 16191 

Signed value 
(-8192 ~ 8191) 

-8192 -8000 -4000 0 4000 8000 8191 

Precise value 
(-60 ~ 5059) 

-120 0 2500 5000 7500 10000 10119 

Percentile value 
(-120 ~ 10119) 

-120 0 2500 5000 7500 10000 10119 
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4) If the range is DC-10 ~ 10 V 
 ▶ On the XG5000 menu [I/O Parameters Setting], set [Input range] to “-10 ~ 10 V”. 

 

 
 

 
 

▶ Digital output value for voltage input characteristics is as specified below. 
(Resolution (based on 1/16000): 1.25 mV) 

 
Analog input voltage (V) Digital 

Output range -0.24 -10 -5 0 5 10 10.23 
Unsigned value 
(-192 ~ 16191) 

-192 0 4000 8000 12000 16000 16191 

Signed value 
(-8192 ~ 8191) 

-8192 -8000 -4000 0 4000 8000 8191 

Precise value 
(-10240 ~ 10238) 

-10240 0 2500 5000 7500 10000 10239 

Percentile value 
(-120 ~ 10119) 

-120 0 2500 5000 7500 10000 10119 
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2.4.2 I/O characteristics of XGF-AC8A 
 

Current input range can be set through user program or special module package for respective 
channels. Output formats of digital data are as specified below; 

 A. Unsigned Value 
 B. Signed Value 
 C. Precise Value 
 D. Percentile Value 

 
1) If the range is DC 4 ~ 20 mA  

 ▶ On the XG5000 menu [I/O Parameters Setting], set [Input range] to “4 ~ 20 ㎃”. 
 

 
 

0

4000

8000

12000

16000
16191

-192
-8000

-4000

0

4000

8000
8192
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0
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20000
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Analog Input Value (Current)  
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 ▶ Digital output value for current input characteristics is as specified below. 
(Resolution (based on 1/16000): 1 μA) 

Analog input current (㎃) Digital 
Output range 3.808 4 8 12 16 20 20.191

Unsigned value 
(-192 ~ 16191) 

-192 0 4000 8000 12000 16000 16191 

Signed value 
(-8192 ~ 8191) 

-8192 -8000 -4000 0 4000 8000 8191 

Precise value 
(3808 ~ 20191) 

3808 4000 8000 12000 16000 20000 20191 

Percentile value 
(-120 ~ 10119) 

-120 0 2500 5000 7500 10000 10119 

 
2) If the range is DC 0 ~ 20 mA 

 ▶ On the XG5000 menu [I/O Parameters Setting], set [Input range] to “0 ~ 20 ㎃”. 
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▶ Digital output value for current input characteristics is as specified below. 

(Resolution (based on 1/16000): 1.25 μA) 
 

Analog input current (㎃) Digital 
Output range -0.24 0 5 10 15 20 20.23 

Unsigned value 
(-192 ~ 16191) 

-192 0 4000 8000 12000 16000 16191

Signed value 
(-8192 ~ 8191) 

-8192 -8000 -4000 0 4000 8000 8191 

Precise value 
(3808 ~ 20191) 

-240 0 5000 10000 15000 20000 20239

Percentile value 
(-120 ~ 10119) 

-120 0 2500 5000 7500 10000 10119

 
Caution  

1) If analog input value exceeding digital output range is input, the digital output value will be kept to be 
the max. or the min. value applicable to the output range specified. For example, if the digital output 
range is set to unsigned value (–192 ~ 16191) and the digital output value exceeding 16191 or 
analog value exceeding –192 is input, the digital output value will be fixed as 16191 or –192. 

2) Voltage and current input shall not exceed ±15 V and ±30 ㎃ respectively. Rising heat may cause 
defects. 

3) Offset/Gain setting for XGF-AV8A/AC8A module shall not be performed by user. 
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2.4.3 Accuracy 

Accuracy of digital output value does not change even if input range is changed. Fig. 2.1 shows the change 
range of the accuracy at ambient temperature of 25 ± 5 ℃ with analog input range of -10 ~ 10 V selected 
and digital output type of Unsigned value selected. ±0.2% of error tolerance is acceptable at ambient 
temperature of 25±5 °C, and ±0.3% at ambient temperature of 0~55°C. 

   
 

 
[Fig. 2.1] Accuracy 
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Functions of A/D conversion module are as described below in Table 2.3.  

[Table 2.3] List of Functions 
Function Item Details 
Channel Run/Stop setting (1) Specify Run/Stop of the channel to execute A/D conversion. 

(2) If the unused channel is set to Stop, whole Run time can be reduced. 
Input voltage/Current range setting (1) Specify analog input range to be used. 

(2) 4 input ranges available for voltage type of module, and 2 input ranges for 
current type of module. 

Output data format setting (1) Specify digital output type. 
(2) 4 output data formats are provided in this module. 

A/D conversion methods (1) Sampling processing 
Sampling process will be performed if A/D conversion type is not specified. 

(2) Filter processing 
Used to delay the sudden change of input value. 

(3) Average processing 
Outputs average A/D conversion value based on frequency or time. 

Function to detect input 
disconnected  

(1) If analog input with the range of 1 ~ 5 V (4 ~ 20 ㎃) is disconnected, user 
program will detect it. 

 
There are three A/D conversion methods, sampling processing, filter processing and average processing. 
 

Sampling Processing

Filter Processing

Average Processing

A/D Conversion Methods

Time Average

Count Average  
 

2.5.1 Sampling processing 
It collects analog input sign through general A/D conversion processing at a specific interval so to 

convert to digital. The time required for A/D conversion of analog input sign till saved on the memory 
depends on the number of channels used.  

 
(Processing time)  = (Number of Channels used) X (Conversion speed) 

 
Ex.) If the number of channels used is 3, its process time will be 

(3) X (250 µs) = 750 μs 
 

Sampling is to calculate the sampling value of continuous analog sign at a specific interval.  

 2.5 Functions of Analog Input Module 
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2.5.2 Filter processing 

Filter process function is used to obtain stable digital output value by filtering (delaying) noise or 
sudden change of input value. Filter constant can be specified for respective channels through user 
program or I/O parameters setting. 

 
• Setting range: 1 ~ 99 (%) 
 

F[n] = (1 - α) x A[n] + α x F [n - 1] 
     F[n]: Present filter output value 
     A[n]: Present A/D converted value 
     F[n-1]: Previous filter output value 
     α: Filter constant (0.01 ~ 0.99: Previous value added) 

 
*1 If filter setting value is not specified within 1 ~ 99, RUN LED blinks at an interval of 1 second. In 

order to set RUN LED to On status, reset the filter setting value within 1 ~ 99 and then convert 
PLC CPU from STOP to RUN. Be sure to use request flag of error clear (UXY.11.0) to clear the 
error through modification during RUN. 

*2 If any error occurs in filter setting value, the default of filter setting value 1 will be saved.  
 

1) In the case of XGF-AV8A 
• Analog input range: DC -10 ~ 10 V, Digital output range: 0 ~ 16000. 
• If analog input value changes –10 V → 10 V (0 → 16000), filter output value based on αvalue is 

as specified below. 
 

Filter output value αvalue  1 scan 2 scan 3 scan 
Remarks  

*1) 0.01 0 15840 15998 15999 1% inclined toward previous value 
*2) 0.5 0 8000 12000 14000 50% inclined toward previous value

*3) 0.99 0 160 318 475 99% inclined toward previous value
*1) 16000 output after about 4 scans  
*2) 16000 output after about 22 scans   
*3) 16000 output after about 1491 scans (372.75 ms for 1 channel Run)  

 
2) In the case of XGF-AC8A 

• Analog input current range: DC 0 ~ 20 ㎃, Digital output range: 0 ~ 16000. 
• If analog input value changes 0 ㎃ → 10 ㎃ (0 → 8000), filter output value based on αvalue is 

as specified below. 
 

Filter output value αvalue  1 scan 2 scan 3 scan 
Remarks 

*1) 0.01 0 7920 7999 7999 1% inclined toward previous value 
*2) 0.5 0 4000 6000 7000 50% inclined toward previous value

*3) 0.99 0 80 159 237 99% inclined toward previous value
*1) 8000 output after about 4 scans  
*2) 8000 output after about 21 scans 
*3) 8000 output after about 1422 scans (355.5 ms for 1 channel Run) 
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• If filter process function is not used, present A/D converted value will be output as it is. The 

filter process function takes value-added data between ‘Present A/D converted value’ and 
‘Previous A/D converted value’. And the value-added data can be decided with filter constant. 
If output data shakes too much, set a big filter constant value. 

 
 

2.5.3 Average processing 
This process is used to execute A/D conversion of the channel designated for specified frequency or 

for specified time and save the average of the accumulated sum on memory. Average processing 
option and time/frequency value can be defined through user program or I/O parameters setting for 
respective channels. 

 
1) What is the average processing used for 

This process is used for A/D conversion of abnormal analog input sign such as noise to a value 
near to normal analog input sign.  

 
2) Average processing type 

Average processing type is of time average and count average. 
 

(1) Time average processing 
A) Setting range: 4 ~ 16000 (ms) 
B) Average processing count within specified time is decided based on the number of channels 

used. 
 

Speed) Conversion( x used) Channels of(Number 
 timeSettingcount  processingAverage =  

 
Ex.1) Channels used: 1, setting time: 16000 ms 
 

times
ms

ms 64000
25.01

16000count  processing Average =
×

=  

 
Ex.2) Channels used: 8, setting time: 4 ms 

 

times
ms

ms 2
25.08

4count  processing Average =
×

=  

 
*1: If setting value of time average is not specified within 4 ~ 16000, RUN LED blinks at 

an interval of 1 second. In order to set RUN LED to On status, reset the setting value 
of time average within 4 ~ 16000 and then convert PLC CPU from STOP to RUN. Be 
sure to use request flag of error clear (UXY.11.0) to clear the error through 
modification during RUN.  

*2: If any error occurs in setting value of time average, the default value 4 will be saved. 
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C) Time average is processed after converted to average of the times inside the A/D 

conversion module. In this case, a remainder may be produced when setting time is divided 
by (number of channels used X conversion speed), which will be disregarded. Thus, the 
average processing frequency will be the quotient of [(setting time) ÷ (number of channels 
used x conversion speed)]. 

 
Ex.) If the number of channels used is 5, and setting time is 151 ms.  

151 ms ÷ (5 X 0.25 ms) = 120 times …… Remainder of 8 → 120 times 
 

(2) Count average process 
A) Setting range: 2 ~ 64000 (times) 
B) The time required for average value to be saved on memory when frequency average used 

depends on the number of channels used. 
Process time = setting frequency X number of channels used X conversion speed 

 
*1: If setting value of count average is not specified within 2 ~ 64000, RUN LED blinks at 

an interval of 1 second. In order to set RUN LED to On status, reset the setting value 
of frequency average within 2 ~ 64000 and then convert PLC CPU from STOP to 
RUN. Be sure to use request flag of error clear (UXY.11.0) to clear the error through 
modification during RUN.. 

*2: If any error occurs in setting value of frequency average, the default value 2 will be 
saved. 

 
Ex.) If the number of channels used is 4, and average processing frequency is 50. 

       50 X 4 X (0.25 ms) = 50 ms 
 
 

2.5.4 Input disconnection detection function  
 

1) Input range available 
If the input sign range of 1 ~ 5 V (4 ~ 20 ㎃) is used, the function to detect input circuit disconnected 
will be available. Detection conditions for respective input sign ranges are as described below in 
the table. 

 
Input signal range Voltage/Current value regarded as disconnected 

1 ~ 5 V 0.2 V or less 
4 ~ 20 ㎃ 0.8 ㎃ or less 

 
2) Disconnection display for respective channels 

Detection sign of disconnection for respective input channels will be saved on UXY. 10.  
(X stands for Base No., and Y for Slot No.) 

 
Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 

Default 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
Assigned - - - - - - - - CH

7 
CH
6 

CH
5 

CH
4 

CH
3 

CH
2 

CH
1 

CH
0 

 
BIT Description 
0 Normal 
1 Disconnected  
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3) Operation  

Each bit will be set to 1 if an assigned channel is detected as disconnected, and back to 0 if 
connected back. In addition, each bit can be used to detect the disconnection in the user program 
together with execution conditions. 

 
4) Program Example 

If a module is installed on Base No.0 and Slot No.2 with detection flag of disconnection used, it will 
be as shown below. If the applicable channel is detected as disconnected, the channel number 
detected will be written on the P area. 
 

(System configuration) 
 
 
 
 
 
 
 
 

 
 

 

 
 
 
 

XGP- 
ACF2

XGK- 
CPUS 

XGF-
AV8A 
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Chapter 3 Installation and Wiring 
 

3.1 Installation 
 

3.1.1 Installation environment 
This product is of high reliance regardless of installation environment. However, for the sake of 
reliance and stability of the system, please pay attention to those precautions described below. 

 
1) Environmental conditions 

- To be installed on the control panel waterproof and dustproof. 
- No continuous impact or vibration shall be expected. 
- Not to be exposed to the direct sunlight. 
- No dew shall be caused by rapid temperature change. 
- Ambient temperature shall be kept 0-55 . ℃  

 
2) Installation work 

- No wiring waste is allowed inside PLC when wiring or drilling screw holes. 
- To be installed on a good location to work on. 
- Don’t let it installed on the same panel as a high-voltage device is on. 
- Let it kept at least 50㎜ away from duct or near-by module. 
- To be grounded in an agreeable place free from noise. 

 
 

3.1.2 Precautions for handling 
Precautions for handling A/D conversion module are as described below from the opening to the 
installation. 
 
1) Don’t let it dropped or shocked hard. 
2) Don’t remove PCB from the case. It will cause abnormal operation 
3) Don’t let any foreign materials including wiring waste inside the top of the module when wiring. 

Remove foreign materials if any inside. 
4) Don’t install or remove the module while powered on. 
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3.2.1 Precautions for wiring  

1) Don’t let AC power line near to A/D conversion module’s external input sign line. With an enough 
distance kept away between, it will be free from surge or inductive noise. 

2) Cable shall be selected in due consideration of ambient temperature and allowable current, whose 
  size is not less than the max. cable standard of AWG22 (0.3㎟). 

3) Don’t let the cable too close to hot device and material or in direct contact with oil for long, which 
will cause damage or abnormal operation due to short-circuit. 

4) Check the polarity when wiring the terminal. 
5) Wiring with high-voltage line or power line may produce inductive hindrance causing abnormal 

operation or defect. 
 

3.2.2 Wiring examples 
1) XGF-AV8A 

 

 
2) XGF-AC8A 

 

 
 

*1) Use a 2-core twisted shielded wire. AWG 22 is recommended for the cable standard.  
*2) XGF-AC8A’s input resistance is 250 Ω (typ.).  
*3) XGF-AV8A’s input resistance is 1 MΩ (min.).  

 3.2 Wiring 
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3) Wiring example of 2-wire sensor/transmitter (current input) 
       

 

 
 

-. Run the channel to be used only. 
-. Analog input module does not provide power for the input device. Use an external power supplier. 

 
 

4) Wiring example of 4- wire sensor/transmitter (voltage/current input) 
 

 

 
 

 
-. Start the channel to be used only. 
-. Analog input module does not provide power for the input device. Use an external power supplier. 

 
* 1) Use a 2-core twisted shielded wire. AWG 22 is recommended for the cable standard.  
* 2) XGF-AC8A’s input resistance is 250 Ω (typ.).  
* 3) XGF-AV8A’s input resistance is 1 MΩ (min.).  

2-Wire 
transmitter 

2-Wire 
transmitter 

4-Wire 
transmitter 

4-Wire 
transmitter 
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5) Relationship between voltage input accuracy and wiring length 

In voltage input, the wiring (cable) length between transmitter or sensor and module has an effect 
on digital-converted values of the module as specified below; 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

      Where, 
        

Rc: Resistance value due to line resistance of cable 
        
       Rs: Internal resistance value of transmitter or sensor 
 
       Ri: Internal resistance value (1㏁) of voltage input module 
  
       Vin: Voltage allowed to analog input module  
 
       % Vi: Tolerance of converted value (%) due to source and cable length in voltage input 
 
 

                 ( )[ ]RiRcRs
VsRiVin

+×+
×

=
2

  

 
 

1001% ×⎟
⎠
⎞

⎜
⎝
⎛ −=

Vs
VinVi %  

   

 
 

Notes  

In current input, there will be no accuracy tolerance caused by cable length and internal resistance of the 
source. 

Vs 

Rs Rc

Rc
Ri 

Load Analog Input (voltage) 

Vin 
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Chapter 4 Operation Procedures and Monitoring 
 

4.1 Operation Procedures  
 
The processing for the operation is as shown in Fig. 4.1.  
 

 
[Fig. 4. 1] Procedures for the operation 
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4.2 Operation Parameters Setting 

 
A/D conversion module’s operation parameters can be specified through XG5000’s [I/O parameters]. 
 
4.2.1 Settings 

For the user’s convenience of A/D conversion module, XG5000 provides GUI (Graphical User 
Interface) for parameters setting of A/D conversion module. Setting items available through [I/O 
parameters] on the XG5000 project window are as described below in the table 4.1.  

 
[Table 4. 1] Function of [I/O Parameters] 

Item Details 
[I/O parameters] (1) Specify the following setting items necessary for the module operation. 

- Channel Enable/Disable setting 
- Setting ranges of input voltage/current 
- Output data format setting 
- Filter processing Enable/Disable setting 
- Filter constant setting 
- Average processing Enable/Disable setting 
- Average processing method setting 
- Average value setting 

(2) The data specified by user through S/W package will be saved on A/D conversion 
module when [Special Module Parameters] are downloaded. In other words, the 
point of time when [Special Module Parameters] are saved on A/D conversion 
module has nothing to do with PLC CPU’s status RUN or SPOP. 

 
4.2.2 I/O parameters 

How to use [I/O parameters] will be described below as based on XGF-AV8A. Sequence of XGF-
AC8A to use is also as identical as specified below. 
 
1)  Run XG5000 to create a project. (Refer to XG5000 program manual for details on how to 

create the project) 
2)  Double-click [I/O parameters] on the project window. 
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3)  On the ‘I/O parameters setting’ screen, find and click the slot of the base A/D conversion 

module is installed on. 8-channel voltage type of A/D conversion module is installed on Base 
No.0, Slot No.4 in this description. 

 

 
 

4)  Click the arrow button on the screen above to display the screen where an applicable module 
can be selected. Search for the applicable module to select. 
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5)  After the module selected, click [Details]. 

 

 
 

6)  A screen will be displayed for you to specify parameters for respective channels as shown 
below. Click a desired item to display parameters to set for respective items. 

 

 
 

(1) Channel status: Select Disable or Enable. 
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(2) Input range: Select the range of analog input voltage as desired. XGF-AV8A provides 4 

voltage input ranges, and XGF-AC8A provides 2 current input ranges. 
 

 
 

(3) Output type: Select the type of output data. 4 formats are available in total. 
 

 
 

(4) Filter process: Set the filter process to Enable or Disable. 
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(5) Filter constant: Set the filter process above surely to [Enable] in order to input the filter 

constant in this field. With the filter process set to [Enable], double-click the value of the 
filter constant to input the value. The range of the value available in this field is 1 ~ 99. Any 
value exceeding this range will not be input. 

 

 
 

(6) Average setting: Set the average setting to Enable or Disable. 
 

 
 

(7) Average processing: Set the average processing above surely to [Enable] in order to 
change the value in this field. Average processing can be selected between time average 
and count average. 
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(8) Average value: Set the average process above surely to [Enable] in order to input the 

average value in this field. With the average process set to [Enable], double-click the 
average value to input the value. The range of the value available in this field is 2 ~ 64000 
for frequency average, and 4 ~ 16000 for time average. Any value exceeding this range will 
not be input 

 

 
 

7)  How to select the whole channels to change parameters 
Click and check the radio button in the parameters item in order to change the whole 
channels to identical setting value. And then change the parameters of an optional channel 
to change the parameters of the whole channels at a time. Fig. 4.2 shows an example 
that Run channel is changed to whole channels ‘Enable’ by means of this function. 

 

 
[Fig. 4. 2] Parameters change of the whole channels 
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4.3 Special Module Monitoring Functions 
 

Functions of Special Module Monitoring are as described below in table 4.2. 
 

[Table 4. 2] Functions of Special Module Monitoring 
Item Details Remarks 

[Special Module 
Monitoring] 

(1) Monitor/Test 
Through applicable XG5000 menu of [Monitor] -> [Special 
Module Monitoring], A/D converted value can be monitored 
and the operation of A/D conversion module can be tested. 

(2) Monitoring the max./min. value  
The max./min. value of the channel can be monitored during 
Run. However, the max./min. value displayed here is based 
on the present value shown on the screen. Accordingly, 
when [Monitoring/Test] screen is closed, the max./min. value 
will not be saved. 

 

 

Notes  

 
The screen may not be normally displayed due to insufficient system resource. In such a case, close the screen 
and finish other applications in order to restart XG5000. 
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4.4 Precautions 
 

 The parameters specified for the test of A/D conversion module on the “Monitor Special Module” 
screen of [Monitor Special Module] will be deleted the moment the “Monitor Special Module” 
screen is closed. In other words, the parameters of A/D conversion module specified on the 
“Monitor Special Module” screen will not be saved in [I/O parameters] located on the left tab of 
XG5000. 

 
 
 

 Test function of [Monitor Special Module] is provided for user to check the normal operation of A/D 
conversion module even without sequence programming. If A/D conversion module is to be used 
for other purposes than a test, use parameters setting function in [I/O parameters]. 

 
 
 

Not saved in [I/O 
parameters]. 
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4.5 Special Module Monitoring  
 
Monitoring special module will be based on XGF-AV8A. Sequence of XGF-AC8A to use is as identical 
as specified below. 

 
4.5.1 Start of [Special Module Monitoring] 

Go through [Online] -> [Connect] and [Monitor] -> [Special Module Monitoring] to start. If the status 
is not [Online], [Special Module Monitoring] menu will not be active. 
 

 
 
 

4.5.2 How to use [Special Module Monitoring] 
1)  With XG5000 connected to PLC CPU (on-line status), click [Monitor] -> [Special Module 

Monitoring] to display ‘Special Module List’ screen as in Fig. 5.1 showing base/slot information 
in addition to special module type. The module installed on the present PLC system will be 
displayed on the list dialog box. 

 

 
[Fig. 5. 1] Screen of [Special Module List]  

  
2) Select Special Module in Fig. 5.1 and click [Module Information] to display the information as in 

Fig. 5.2.  
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[Fig. 5. 2] Screen of [Special Module Information]  

 
3)  Click [Monitor] on the “Special Module” screen in Fig. 5.1 to display [Special Module 

Monitoring] screen as in Fig. 5.3, where 4 options are available such as [Reset max./min. 
value], [Start Monitoring], [Test] and [Close]. A/D conversion module’s output value and max./ 
min. value are displayed on the monitoring screen at the top of the screen, and parameters 
items of respective modules are displayed for individual setting on the test screen at the 
bottom of the screen. 

 

 
[Fig. 5. 3] [Special Module Monitoring] screen  

 
(1) [Start Monitoring]: Click [Monitor Start] to display A/D converted value of the presently 

operated channel. Fig. 5.4 is the monitoring screen displayed when the whole channels of 
XGF-AV8A are in Stop status. In the present value field at the screen bottom, presently 
specified parameters of A/D conversion module are displayed. 
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[Fig. 5. 4] Execution screen of [Start Monitoring]  

 
 

(2) [Test]: [Test] is used to change the presently specified parameters of A/D conversion 
module. Click the setting value at the bottom field of the screen to change parameters. Fig. 
5.5 will be displayed after [Test] is executed with channel 0’s input voltage range changed 
to -10 ~ 10 V in the state of input not wired. 

 

 
[Fig. 5. 5] Execution screen of [Test] 
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(3) [Reset Max./Min. value]: The max./min. value field at the upper screen shows the max. 

value and the min. value of A/D converted value. Click [Reset max./min. value] to initialize 
the max./min. value. Fig.5.6 is after [Reset max./min. value] button is clicked in the Fig. 5.5, 
where channel 0’s A/D converted value can be checked as reset. 

 

 
[Fig. 5. 6] Execution screen of [Reset max./min. value]  

  
 
(4) [Close]: [Close] is used to escape from the monitoring/test screen. When the monitoring/test 

screen is closed, the max. value, the min. value and the present value will not be saved any 
more. 
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4.6 Register U Devices 
 

This section describes the automatic registration function of the U device in the XG5000 
 
4.6.1 Register U devices 
 

Register the variables for each module referring to the special module information that is set in 
the I/O parameter. The user can modify the variables and comments.  
 
 [Procedure] 
1) Select the special module type in the [I/O parameter setting] window. 
 

 
 

2) Double click ‘Variable/Comment’ from the project window. 
 

 
 
3) Select [Edit] -> [Register U Device]. 
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4)  Click ‘Yes’ 
 

 
 
5) As shown below, the variables are registered. 
 

 
 

 
4.6.2 Save variables 
 

1) The contents of ‘View Variable’ can be saved as a text file. 
2) Select [Edit] -> [Export to File]. 
3) The contents of ‘View variable’ are saved as a text file. 
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4.6.3 View variables 
 

1) The example program of XG5000 is as shown in below.  
 

 
 
2) Select [View] -> [Variables]. The devices are changed into variables. 
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4) Select [View] -> [Devices/Variables]. Devices and variables are both displayed. 
 

 
 
5) Select [View] -> [Device/Comments]. Devices and comments are both displayed. 
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Chapter 5 Configuration and Function of Internal Memory 
A/D conversion module has the internal memory to transmit/receive data to/from PLC CPU. 
 

5.1 Internal Memory Configuration  
Configuration of internal memory is as described below. 

 
5.1.1 I/O area of A/D converted data  

I/O area of A/D converted data is as displayed in Table 5.1. 
 

[Table 5. 1] I/O area of A/D converted data  

Device assigned Details R/W Sign direction

UXY.00.0 
UXY.00.F 

Module ERROR flag  
Module READY flag R A/D → CPU 

UXY.01.0 
UXY.01.1 
UXY.01.2 
UXY.01.3 
UXY.01.4 
UXY.01.5 
UXY.01.6 
UXY.01.7 

CH0 Run flag 
CH1 Run flag 
CH2 Run flag 
CH3 Run flag 
CH4 Run flag 
CH5 Run flag 
CH6 Run flag 
CH7 Run flag 

R A/D → CPU 

UXY.02 CH0 digital output value R 
UXY.03 CH1 digital output value R 
UXY.04 CH2 digital output value R 
UXY.05 CH3 digital output value R 
UXY.06 CH4 digital output value R 
UXY.07 CH5 digital output value R 
UXY.08 CH6 digital output value R 
UXY.09 CH7 digital output value R 

A/D → CPU 
 

UXY.10.0 
UXY.10.1 
UXY.10.2 
UXY.10.3 
UXY.10.4 
UXY.10.5 
UXY.10.6 
UXY.10.7 

Flag to detect CH0 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH1 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH2 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH3 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH4 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH5 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH6 disconnection (1 ~ 5 V or 4 ~ 20 mA)
Flag to detect CH7 disconnection (1 ~ 5 V or 4 ~ 20 mA)

R A/D → CPU 

UXY.11.0 Flag to request error clear W CPU → A/D 
 
1) In the device assigned, X stands for the Base No. and Y for the Slot No. on which module is 

installed. 
2) In order to read ‘CH1 digital output value’ of A/D conversion module installed on Base No.0, Slot 

No.4, it shall be displayed as U04.03. 
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3) In order to read ‘Flag to detect CH4 disconnection’ of A/D conversion module installed on Base 
No.0, Slot No.5, it shall be displayed as U05.10.4. 

 

 
 
 

5.1.2 Operation parameters setting area  
Setting area of A/D conversion module’s Run parameters is as described in Table 5.2. 

 
[Table 5. 2] Setting area of Run parameters  

Memory address 
Hex Dec 

Details R/W Remarks 

0H 0 Channel enable/disable setting R/W PUT 
1H 1 Setting ranges of input voltage/current R/W PUT 
2H 2 Output data format setting R/W PUT 

3H 3 Filter processing enable/disable 
setting R/W PUT 

4H 4 CH0 filter constant  
5H 5 CH1 filter constant  
6H 6 CH2 filter constant  
7H 7 CH3 filter constant  
8H 8 CH4 filter constant  
9H 9 CH5 filter constant 
AH 10 CH6 filter constant  
BH 11 CH7 filter constant  

R/W 
 PUT 

CH 12 Average processing enable/disable 
setting 

R/W 

DH 13 Average processing method setting R/W 
EH 14 CH0 average value  
FH 15 CH1 average value  
10H 16 CH2 average value  
11H 17 CH3 average value  
12H 18 CH4 average value  
13H 19 CH5 average value  
14H 20 CH6 average value  
15H 21 CH7 average value  

R/W 

PUT 

16H 22 Error code R/W GET 
 R/W※  is to denote Read/Write if available from PLC program. 
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5.2 A/D Converted Data I/O Area  
 
5.2.1 Module READY/ERROR flag (UXY.00, X: Base No., Y: Slot No.) 

1)  UXY.00.F: It will be ON when PLC CPU is powered or reset with A/D conversion ready to process 
      A/D conversion. 

2)  UXY.00.0: It is a flag to display the error status of A/D conversion module. 
 
 
 
 
 
 
 
 
 
 
5.2.2 Run channel flag (UXY.01, X: Base No., Y: Slot No.) 

The area where Run information of respective channels is saved. 
 
 
 
 
 
 
 
 
 
5.2.3 Digital output value (UXY.02 ~ UXY.09, X: Base No., Y: Slot No.) 

1)  A/D converted-digital output value will be output to buffer memory addresses 2 ~ 9 (UXY.02 ~ 
UXY.09) for respective channels. 

2)  Digital output value will be saved in 16-bit binary. 
                              

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0

Channel # digital output value 
                                

 

Address Details 

Address No.2 CH0 digital output value 
Address No.3  CH1 digital output value 
Address No.4  CH2 digital output value 
Address No.5  CH3 digital output value 
Address No.6  CH4 digital output value 
Address No.7  CH5 digital output value 
Address No.8  CH6 digital output value 
Address No.9  CH7 digital output value 

 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

R
D
Y

— — — — — — — — — — — — — — 
E 
R 
R 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

— — — — — — — —
C
H
7

C
H
6

C
H
5

C
H
4

C
H
3

C
H
2

C
H
1 

C
H
0 

Run channel information 
Bit ON (1): During Run, Bit Off (0): Operation Stop 

Error information 
Bit ON (1): Error, Bit Off (0): Normal 

Module READY 
Bit ON (1): READY, Bit Off (0): NOT READY

UXY.00 

UXY.01 

UXY.02 ~ UXY.09 
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5.2.4 Flag to detect disconnection (UXY.10.Z, X: Base No., Y: Slot No., Z: Channel No.) 

1)  Detection sign of disconnection for respective input channels is saved in UXY.10. 
2)  Each bit will be set to 1 if an assigned channel is detected as disconnected, and it will be back to 0 

if connected back. In addition, each bit can be used to detect the disconnection in the user program 
together with execution conditions. 

 
 

 
 
 

 
 

BIT Description 
0 Normal 
1 disconnection 

 
 
5.2.5 Flag to request error clear (UXY.11.0, X: Base No., Y: Slot No.) 

1)  If a parameters setting error occurs, address No.22’s error code will not be automatically erased 
even if parameters are changed correctly. At this time, turn the ‘error clear request’ bit ON to delete 
address No.22’s error code and the error displayed in XG5000’s [System Monitoring]. In addition, 
RUN LED which blinks will be back to On status. 

2)  The ‘flag to request error clear’ shall be used surely together with UXY.00.0 attached thereon for 
guaranteed Normal operation. Its application shall be as shown below in Fig. 5.1. 

 
 

 
 
 

 
 
 
 

 
 

[Fig. 5. 1] How to use the flag 
 

 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

— — — — — — — —
C
H

7

C
H

6

C
H

5

C
H

4

C
H

3

C
H

2

C
H 

1 

C
H 

0 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

— — — — 
-

—
— — — — — — — — — — 

E 

C 

R 

Flag to request error clear (UXY.11.0) 
Bit ON (1): Error clear request, Bit Off (0): Error clear standing-by 

UXY.10 

UXY.11.0 



Chapter 5 Configuration and Function of Internal Memory 

5-5 

 

5.3 Operation Parameters Setting Area  
 

 ▶ 1 word is assigned for each address in the internal memory, which can be displayed in 16 bits. 
 ▶ If each bit of 16 bits configuring the address is On, let it set to “1”, and if it is Off, let it set to “0” so to 
realize the respective functions.  

 
 
5.3.1 How to specify the channel to use (address No.0) 

1)  Allowed/Prohibited A/D conversion can be set for respective channels. 
2)  Set the unused channel Prohibited from converted so to reduce the conversion cycle for respective 

channels. 
3)  If the channel to use is not specified, all the channels will be set to Prohibited. 
4)  Allowed/Prohibited A/D conversion is as specified below. 

 
 

 
 
 

 
 

BIT Description 
0 Disable 
1 Enable 

 
5) The value specified in B8 ~ B15 will be disregarded. 

 
5.3.2 How to specify the range of input voltage/current (address No.1) 

1)  The range of analog input voltage/current can be specified for respective channels. 
2)  If the analog input range is not specified, the range of all the channels will be set to 1 ~ 5 V (4 ~ 20 

  mA). 
3)  Setting range of analog input voltage/current is as specified below. 

 
(1) XGF-AV8A 

 
B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

C 

H 

7 

C 

H 

6 

C 

H 

5 

C 

H 

4 

C 

H 

3 

C 

H 

2 

C 

H 

1 

C 

H 

0 
 

 
BIT Description 
00 1 V ~ 5 V 
01 0 V ~ 5 V 
10 0 V ~ 10 V 
11 -10 V ~ 10 V 

 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

— — — — — — — —
C
H

7

C
H

6

C
H

5

C
H

4

C
H

3

C
H

2

C
H 

1 

C
H 

0 

Address “0” 

Address “1” 
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(2) XGF-AC8A 

 
B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

C 

H 

7 

C 

H 

6 

C 

H 

5 

C 

H 

4 

C 

H 

3 

C 

H 

2 

C 

H 

1 

C 

H 

0 
 

 
BIT Description 
00 4 mA ~ 20 mA 
01 0 mA ~ 20 mA 

 
 

5.3.3 How to specify the range of output data (address No.2) 
1)  The range of digital output data for analog input can be specified for respective channels. 
2)  If the output data range is not specified, the range of all the channels will be set to 0 ~ 16000. 
3)  Setting range of digital output data range is as specified below. 

 
B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

C 

H 

7 

C 

H 

6 

C 

H 

5 

C 

H 

4 

C 

H 

3 

C 

H 

2 

C 

H 

1 

C 

H 

0 
 

 
BIT Description 
00  0 ~ 16000 
01 -8000 ~ 8000 
10 Precise Value 
11 0 ~ 10000 

 
Precise value has the following digital output ranges for the analog input range. 

 
(1) XGF-AV8A 

 
     Analog input 
 
Digital output 

-10 ~ 10V 0 ~ 10V 0 ~ 5V 1 ~ 5V 

Precise Value -10000 ~ 
10000 0 ~ 10000 0 ~ 5000 1000 ~ 5000 

 
(2) XGF-AC8A 

 
     Analog input 
 
Digital output 

4 ~ 20 ㎃ 0 ~ 20 ㎃ 

Precise Value 4000 ~ 20000 0 ~ 20000 
 

Address “1” 

Address “2” 
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5.3.4 How to specify filter process (address No.3) 

1)  Allowed/Prohibited filter process can be specified for respective channels. 
2)  If the filter process is not specified, all the channels will be sampled. 
3)  Setting of the filter process is as specified below. 

 
B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

— — — — — — — —
C
H
7

C
H
6

C
H 
5

C
H
4

C
H
3

C
H
2

C
H 
1 

C 
H 
0 

  
 

BIT Description 
0 Disable 
1 Enable 

 
5.3.5 How to specify filter constant (address No.4 ~ 11) 

1)  Default of the filter constant is 1.  
2)  Setting range of the filter constant is 1 ~ 99. 
3)  If other value exceeding the setting range is specified, error code 50# will be displayed on display 

 address (22) of the error code. At this time, A/D converted value keeps the previous data. (# of the 
 error code stands for the channel with error found) 

4)  If the filter constant is not specified, the filter constant will be set to ‘1’. 
5)  Setting of the filter constant is as specified below. 

 
 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

— — — — — — — — Channel# filter value 
  

 
 

Address Details 
Address No.4 CH0 filter value  
Address No.5  CH1 filter value 
Address No.6  CH2 filter value 
Address No.7  CH3 filter value 
Address No.8  CH4 filter value  
Address No.9  CH5 filter value 

Address No.10 CH6 filter value 

Address No.11 CH7 filter value 
 

Notes  

In order to make filter constant effective, the filter process shall be previously set to ‘Allowed’. 

 

Address “3” 

Setting range of filter constant is 1 ~ 99 

Address “4 ~ 11” 
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5.3.6 How to specify average process (address No.12) 

1)  Allowed/Prohibited average process can be specified for respective channels. 
2)  If the average process is not specified, all the channels will be sampled. 
3)  Setting of the average process is as specified below. 

 
 
 

 
 
 
 

BIT Description 
0 Disable 
1 Enable 

 
 

5.3.7 How to specify average processing method (address No.13) 
1)  This area is used to specify average processing method, where ‘count average’ and ‘time average’ 

are available.  
2)  If any time/count average process is not specified, all the channels will be set to count average 

process. 
 

 
 
 
 
 
 

BIT Description 
0 Count average 
1 Time average 

 

Notes  

In order to specify time/count average process value, the average process shall be previously set to ‘Allowed’. 

 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

— — — — — — — —
C
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7
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H
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H
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C
H 
0 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

— — — — — — — —
C
H
7

C
H
6

C
H
5

C
H
4

C
H
3

C
H
2

C
H 
1 

C 
H 
0 

Address “12” 

Address“13” 
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5.3.8 How to specify average value (address No.14 ~ 21) 

1)  Setting range of time/count average’s constant value is as specified below. 
(1) Setting range of time average: 4 ~ 16000 (ms) 
(2) Setting range of count average: 2 ~ 64000 (times) 

2)  In case other value exceeding the setting range is specified, (1) Error No. 60X will be displayed if    
time average range exceeded, and (2) Error No. 70X will be displayed if count average range 
exceeded on the display address of the respective error codes. At this time, the default of average 
process will be applied and calculated.  

3)  If the process value of time/count average is not specified, the default will be applied and 
calculated. (Time average: 4, Count average: 2)  

4)  The process value of time/count average is as specified below. 
 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

— — — — — — — — Channel# average value 

 
 

 

Address  Details 

14 CH0 average value  
15  CH1 average value  
16 CH2 average value  
17 CH3 average value  
18 CH4 average value  
19 CH5 average value  
20 CH6 average value  
21 CH7 average value  

 

Notes  
In order to specify the process value of time/count average, the average process shall be previously set to 
‘Allowed’. In addition, an average processing method shall be selected between time average and count average 
as desired. 

 

Setting range of time average process value is 4 ~ 16000 
Setting range of count average process value is 2 ~ 64000 

Address “14 ~ 21” 
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5.3.9 Error code (address No.22) 

1)  Error codes detected from A/D conversion module will be saved. 
2)  Error types and details are as specified below. 

 
B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

— — — — — — — — Error code 
  

 
 

Error Code 
(Dec) Error Details Remarks 

0 Normal Run RUN LED On 

20 Module error (A/D Conversion Error) RUN LED flickers every 0.2
sec. 

40# Offset value with the range of 1 ~ 5 V (4 ~ 20 mA) 
is set greater than or equal to Gain value. 

41# Offset value with the range of 0 ~ 5 V (0 ~ 20 mA)
is set greater than or equal to Gain value. 

42# Offset value with the range of 0 ~ 10 V is set 
greater than or equal to Gain value. 

43# Offset value with the range of -10 ~ 10 V is set 
greater than or equal to Gain value. 

50# Filter constant setting range exceeded 
60# Time average setting range exceeded 
70# Count average setting range exceeded 

RUN LED flickers every 11
sec. 

80# Analog input range setting error Applied to XGF-AC8A 
 ※ # of the error code stands for the channel with error found. 
 ※ Refer to 7.1 for more details on error codes. 

 
3)  If 2 or more errors occur, the module will not save other error codes than the first error code found. 
4)  If an error found is corrected, use the ‘flag to request error clear’ (refer to 5.2.5), or let power OFF 

 ON in order to stop LED blinking and to delete the error code. 
 
 
 
 

Refer to the table below for detailed error codes. 

Address “22” 
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Chapter 6 Programming 
 

6.1 Read/Write of Operation Parameters Setting Area  
Configuration of the internal memory is described as below. 

6.1.1 Read of operation parameters setting area (GET, GETP instruction) 

  

 

 

                                           

                           < Difference between GET instruction and GETP instruction > 

        GET  : always executed with execution condition On      (                  ) 

        GETP : executed with execution condition of operation start (                  ) 

 

If A/D conversion module is installed on Base No.0 and Slot No.3, and internal memory 

addresses No.0 & 1’s data in A/D conversion module is read to D0 and D1 of CPU module, 

  

(Address) D area of CPU module                   Internal memory    (Address)    

D0 CH enable/disable setting CH enable/disable setting 0 

D1 Range setting of input voltage/ 
current  

Range setting of input voltage/ 
current 1 

 - -  

 - -  

 - 

 

-  

 

 

 

 

Type Description Area available 

n1 Slot No. the special module is installed on Integer 

n2 Start address of setting area of special module’s Run parameters 
to read data. Integer 

D Device’s start address with saved data to read M, P, K, L, T, C, D, #D

n3 Number of words data to read Integer 

GET instruction 
Execution condition 

  GET     n1    n2     D     n3 

Type 

Ex. 
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6.1.2 Write of operation parameters setting area (PUT, PUTP instruction) 
 

 

 

                                                                                                            

                          < Difference between PUT instruction and PUTP instruction > 

        PUT  : always executed with execution condition On      (                  ) 

        PUTP : executed with execution condition of operation start (                  ) 

 

 If A/D conversion module is installed on Base No.0 and Slot No.6, and CPU module’s data 

of D10~D13 is written on internal memory addresses 12~15 of A/D conversion module, 

 

(Address) D area of CPU module                   Internal memory    (Address)    

D10 
Average processing 

enable/disable setting 

Average processing 

enable/disable setting 
12 

D11 Average processing method 
setting 

Average processing method 
setting 13 

D12 CH0 average value setting CH0 average value setting 14 

D13 CH1 average value setting CH1 average value setting 15 

 - 

 

-  

 

 

 

 

 

 

 

 

Type Description Area available 

n1 Slot No. the special module is installed on Integer 
n2 Start address of special module’s internal memory to write data. Integer 

S Device’s start address or integer with saved data to write. M,P,K,L,T,C,D,#D,integer

n3 Number of words data to write Integer 

PUT command 
Execution condition 

  PUT     n1    n2     S     n3 

Type 

Ex. 
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6.2 Basic Program 
 

- How to specify Run condition details of A/D conversion module’s internal memory will be described. 

- A/D conversion module is as installed on Slot 2. 

- I/O assigned points of A/D conversion module is 16 points (changeable). 

- Initial value specified will be saved on the internal memory of A/D module through one time of input 

under the initial setting condition. 

 

6.2.1 XGF-AV8A 
1)  Program example using [I/O parameters] setting  
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2) Program example using PUT/GET instruction  

 

 

Module READY Execution contact 

Device with saved data to transmit  
Device with saved data transmitted 

CH Run flag 

Slot No. Internal memory address 

Device to save  
The number of data to read 

CH0 digital output 

CH3 digital output 

CH4 digital output 

Module READY Execution contact 

CH Run flag 

Used CH setting 
(CH0,3,4) 
Input voltage range setting 
(-10~10V) 
Output data range setting 
(-192~16191) 
Filter process setting 
(CH0,3,4) 
CH0 filter constant setting 

CH3 filter constant setting  

CH4 filter constant setting  
Average process setting 
(CH0,3,4) 
Average processing  
method setting 

CH0 average value setting

CH3 average value setting

CH4 average value setting

CH0 digital output

CH3 digital output

CH4 digital output

Slot No. 
Internal memory address 

Setting data 
The number of data to write 

Error code Read 

P00041 

P00041 

P00041 
P00041 
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6.2.2 XGF-AC8A 
1) Program example using [I/O parameters] setting  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 

 
 

Module READY Execution contact 

Device with saved data to transmit

 
Device with saved data transmitted 

CH Run flag 

Slot No. 

Internal memory address

Device to save 
The number of data to read 

CH0 digital output 

CH3 digital output 

CH4 digital output 

Error code Read 

P00041 

P00041 
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2) Program example using PUT/GET instruction  

Module READY 

Execution contact 

CH Run flag 

Used CH setting 
(CH0,3,4) 
Input current range setting 
(4~20mA) 
Output data range setting 
(-192~16191) 
Filter process setting 
(CH0,3,4) 
CH0 filter constant setting  

CH3 filter constant setting 

CH4 filter constant setting  
Average process setting 
(CH0,3,4) 
Average processing method 
setting

CH0 average value setting

CH3 average value setting

CH4 average value setting

CH0 digital output

CH3 digital output

CH4 digital output

Slot No. 
Internal memory address 

Setting data 
The number of data to write 

P00041 

P00041 
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6.3 Application Program 
 

6.3.1 Program to sort A/D converted value in size (I/O slot fixed-points assigned: 
based on 64) 

1) System configuration 
 

 

 
 
 
 
 

2) Details of initial setting  
 

No. Item Details of initial setting Internal memory 
address 

Value to write on internal 
memory 

1 Used CH CH0, CH2, CH4 0 ‘h0015’ or ‘21’ 

2 Input voltage range -10 ~ 10 V 1 ‘hFFFF’ or ‘65535’ 

3 Output data range 0 ~ 16000 2 ‘h0000’ or ‘0’ 

4 Filter process CH0 3 ‘h0001’ or ‘1’ 

5 CH0 filter constant 50 4 ‘h0032’ or ‘50’ 

6 Average process CH2, CH4 12 ‘h0014’ or ‘20’ 

6 Average 
processing method 

Frequency average: CH2
Time average: CH4 

13 ‘h0010’ or ‘16’ 

Frequency average 
value: 100 (times) 

16 ‘h0064’ or ‘100’ 
7 Average value 

Time average value: 200 
(ms) 

18 ‘h00C8’ or ‘200’ 

 

3) Program description 
(1) If CH 0’s digital value is less than 12000, Contact No.0 (P00080) of relay output module 

installed on Slot No.2 will be On 

(2) If CH 2’s digital value is greater than 13600, Contact No.2 (P00082) of relay output module 

installed on Slot No.2 will be On. 

(3) If CH 4’s digital value is greater than or equal to 12000 and less than or equal to 13600, 

Contact No.4 (P00084) of relay output module installed on Slot No.2 will be On. 

(4) If CH 4’s digital value is equal to 13600, Contact No.5 (P00085) of relay output module installed 

on Slot No.2 will be On. 

XGP- 

ACF2 

XGK- 

CPUS 

XGI- 

D24A 

XGF- 

AV8A 

XGQ-

RY2A



Chapter 6 Programming 
 

6-8 
 

 

4) Program 

(1) Program example using [I/O parameters] setting  

 

 

 

 

 

 

Module READY Execution contact 

Slot No.

Device to save 

The number of data to read 

Error code Read 

CH Run flag 

Internal memory address 
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(2) Program example using PUT/GET instruction  

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

CH enable/disable 
setting (CH0,2,4) 

Input voltage range setting
(-10~10v) 
Output data range setting 
(-192~16191) 
Filter process setting 
(CH0) 
CH0 filter constant setting  

Average process setting 
(CH2, 4) 
Average processing method
setting (CH2,4) 
CH2 average value setting

CH4 average value setting

Module READY Execution contact 

Slot No. Internal memory
address 

Setting data The number of data to write 

CH Run 
sign 

If CH4’s A/D converted value is greater than 12000 and less than 13600, P0085 will be On 
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6.3.2 Program to output error codes of analog input module to BCD display 

1) System configuration 
 

 

 
 
 
 
 

 

 
 
 
 
 

2) Details of initial setting  
(1) Used CH: CH 0 

(2) Analog input current range: DC 4 ~ 20 mA 

(3) Time average process setting: 100 (ms) 

(4) Digital output data range: 0 ~ 16000 

 

3) Program description 
(1) If P00000 is On, A/D conversion will be initially specified. 

(2) If P00001 is On, A/D converted value and error code will be saved respectively on D00000 and 

D00001. 

(3) If P00002 is On, applicable error code will be output to digital BCD display. (P00040 ~ P0004F) 

XGP- 

ACF2 

XGK- 

CPUS 

XGI- 

D24A 

XGQ- 

RY2A 

XGF- 

AV8A 

Digital BCD display 
(error display) 

XGQ- 

RY2A 

Initial value setting

Error code output to BCD 

P0000 

P0001 

P0002 

A/D converted value & 
error code saved 
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4) Program  
 

(1) Program example through [I/O parameters] setting 

 

 

 

 

Channel enable/disable 
setting (CH0) 

Save CH0’s A/D converted 
value on D0 
Save error code on D1 

Convert D1 saved data to BCD to
output to P040 

Module READY Execution contact

Run channel sign 

Conversion setting of error code to BCD 
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(2) Program example using PUT/GET instruction  

 

 

 

Used Channel setting 
(CH0) 

Save CH0’s A/D conversion
value on D0 
Save error code on D1 

Convert D1 saved data to
BCD to output to P040 

Module READY Execution contact 

Channel Run flag 

Conversion setting of error code to BCD 

Input current range setting
(4~20mA) 
Output data range setting 
(-192~16191) 
Average process setting 
CH0 
Average processing method
setting (CH0) 
Average value setting 
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Chapter 7 Troubleshooting 
Details and diagnosis of errors which occur while analog input module is used will be described. 
 

7.1 Error Codes 
 

Errors which occur when A/D conversion module’s RUN LED blinks are as described in Table 7.1. 
 

[Table 7. 1] List of error codes  
Error code 

(Dec) Description  RUN LED 
status 

10  Module error (ASIC Reset Error) 
11  Module error (ASIC RAM or Register Error) 
20  Module error (A/D Conversion Error) 
30  Module error (EEPROM Error) 

Flickers 
every 0.2 

sec. 

40# Module error (Offset value with the range of 1 ~ 5 V or 4 ~ 20 mA is 
set greater than or equal to Gain value.) 

41# Module error (Offset value with the range of 0 ~ 5 V or 0 ~ 20 mA is 
set greater than or equal to Gain value.) 

42# Module error (Offset value with the range of 0 ~ 10 V is set greater 
than or equal to Gain value.) 

43# Module error (Offset value with the range of -10 ~ 10 V is set greater 
than or equal to Gain value.) 

50# Filter constant setting range exceeded 
60# Time average setting range exceeded 
70# Count average setting range exceeded 
80# Analog input range setting error(only for XGF-AC8A) 

Flickers 
every 1 sec.

 
Notes  

(1) # of the error code stands for the channel with error found. 
(2) If 2 or more errors occur, the module will not save other error codes than the 

first error code found. 
(3) Use the flag to request error clear to delete the error code from the sequence 

program. (Refer to 5.2.5) 
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7.2 Troubleshooting 
 

7.2.1 RUN LED blinks 
 

 
 

Error Code 
(Dec) Error Details Action 

40# 

41# 

42# 

43# 

Module Offset/Gain error 

Let the power ON/OFF again. If the error occurs again, 
 it seems to be a module defect. Contact the nearest agency
 or LS branch office. 

 

50# Filter constant setting range 
exceeded Change filter constant setting value within 1 ~ 99. 

60# Time average setting range 
exceeded Change time average setting value within 4 ~ 16000. 

70# Frequency average setting 
range exceeded 

Change frequency average setting value within 2 ~ 
64000. 

80# Analog input range error 
(Only XGF-AC8A) 

Refer to the section 5.3.2 Parameter Setting Range 
Address 1 and then change the analog input range. 

 

RUN LED flickers. 

RUN LED flickers every 0.2 sec. 

Let the power ON/OFF again. If the error occurs again, 
 it seems to be a module defect. Contact the nearest agency
 or LS branch office. 
 

RUN LED flickers every 1 sec. 

It is Run parameters setting error. Check the error code to 
take action against as follows in the table below. 

Yes 

No 

Yes 
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7.2.2 RUN LED is Off 
 

 
 
 

7.2.3 CPU module cannot read A/D converted value 
 

 
 

RUN LED is Off. 

A/D conversion module is installed on the 
base correctly 

Correctly install A/D conversion module on the base.

Capacity of power module installed on the 
base is sufficient. 

Check the system configuration again with each 
module’s consumed current calculated correctly

Normally operated if A/D conversion 
module with error is changed to another 

module 

Error due to other module than A/D 
conversion module. Refer to CPU manual 

for more details. 

Go to 7.2.5 

No 

Yes 

No 

Yes 

Yes 

No 

CPU module can not read A/D converted value.

Used channel is set correctly. 
Check the channel number to use and let it correctly

specified. 

Specified CH’s input terminal wiring is 
correct. 

Refer to 3.2.2 to correct wiring. 

Go to 7.2.5. 

No 

Yes 

No 

Yes 
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7.2.4 Relationship discordant between analog input value & digital output value 

 

 
 
 

7.2.5 H/W error of A/D conversion module  
 

 
 

7.2.6 Status check of A/D conversion module through XG5000 system monitor 
Module type, module information, O/S version and module status of A/D conversion module can be 
checked through XG5000 system monitoring function. 
 
1) Execution sequence 

Two routes are available for the execution. 
(1) [Monitor] -> [System Monitoring] -> And on the module screen, click the right mouse button to 

display [Module Information]. 
(2) [Monitor] -> [System Monitoring] -> And Double-click the module screen. 

 
2) Module information 

(1) Module type: shows the information of the module presently installed. 
(2) Module information: shows the O/S version information of A/D conversion module. 
(3) O/S version: shows the O/S prepared date of A/D conversion module. 
(4) Module status: shows the present error code. (Refer to 7.1 for detailed error codes) 

Let the power ON/OFF again. If the error occurs again, it seems to
 be a module defect. Contact the nearest agency or LS branch 

office. 
 

Refer to 3.2.2 to correct wiring. 

Go to 7.2.5 

Analog input terminal’s wiring is correct. 

Each CH’s analog input type and connected 
input type is correct as specified. 

Check the used analog input type if set 
correctly. 

No 

Yes 

Relationship between analog input value 
and digital output value is not discordant.

No 

Yes 
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Appendix 1 Terminology 
 

Terms and abbreviation used in the user’s manual and the analog module in general are as described below. 

 

■ A/D converter: converts analog to digital value proportionately to the size of analog input signal. 

   

■ Analog input module: as a module with the circuit to convert analog voltage/current input signal to digital 

value, it has resolution of 14 and 16 bits according to converters. 

 

■ Channel: related with the terminal of analog I/O module and connected to various voltage/current I/O 

devices respectively, with applicable data and diagnosis function as well. 

 

■ Conversion time: time necessary for analog input module to sample and convert the analog signal for the 

processor inside the module to get digital-converted value input. On the other hand, it is time necessary for 

analog output module to convert the digital value output from the processor inside the module to analog 

output signal so to transmit to the output channel. 

  

■ D/A converter: related with the output module, it is used to make continuous size of analog voltage and 

current signal proportionately to the digital value.   

 

■ Full scale: defined as the size of voltage/current where the normal operation is executed.   

 

■ Full scale error: displayed with graph difference between agreeable analog-converted value and actual 

analog-converted value. 

   

■ Full scale range: displayed with difference between the maximum and the minimum of the analog input. 

 

■ LSB (Least Significant Bit): displays the min. value of the bit unit. 
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■ Linearity error: analog I/O is related between continuous voltage/current value and digital value, whose 

agreeable I/O value is defined as a line within a distance of the min. 1LSB of voltage/current. I/O linearity 

error is regarded as the declination between the agreeable-converted value and the actual-converted value 

on the graph. 

 

 

 

 

 

 

 

 

 

■ Multiplexer: a switching circuit where many signals share one A/D converter or D/A converter. 

 

■ Analog output module: a module with output circuit to convert analog DC voltage or current signal 

proportionate to digital value delivered to the module from the processor. 

 

■ Resolution: the min. value recognizable by a measuring instrument, which is usually displayed in the 

engineering unit (1mv) or the number of bits. In other words, 16383 types of output are available for 14 bits. 

 

■ Filter: used to reduce the change of the digital-converted value output by sudden change of the external 

noise or input for the analog circuit, through two methods of S/W and H/W filters. 

 

■ Accuracy: displayed with the max. declination between agreeable value and output voltage or current for 

the whole range of output. On the other hand, it is displayed with the max. declination between agreeable 

value and digital-converted input signal value for the whole range of input. Generally, percentage will be 

displayed for the full scale. 

Gain, Offset and Linearity error are all included in the error type available. 

 

■ Output accuracy: displayed with the difference between the actual analog output voltage/current value 

and the agreeable-converted value on the conversion graph for the full scale, with Offset, Gain and Drift 

error factors included as well as normal temperature (25℃) and available temperature range displayed 

respectively. 

Agreeable-converted value 

Actual-converted value 



Appendix 
 
 

Appendix-3 

 

Appendix 2 External Dimensions 
 

1) External dimensions of XGF-AV8A/AC8A 
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 Warranty                                                           
 
 
1. Terms of warranty 

LSIS provides an 18-month warranty starting from the date of production. 
 
 
2. Range of warranty 

For problems within the terms of the warranty, LSIS will replace the entire PLC or repair the defective parts free 
of charge except for the following cases. 
 
(1) Problems caused by improper conditions, environment or treatment. 
(2) Problems caused by external devices. 
(3) Problems caused by the user remodeling or repairing the PLC. 
(4) Problems caused by improper use of the product. 
(5) Problems caused by circumstances where the expectations exceed that of the science and technology level 

when LSIS produced the product. 
(6) Problems caused by natural disaster. 

 
 
3. This warranty is limited to the PLC itself only. It is not valid for the whole system which the PLC is attached to. 
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